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[bookmark: _Toc506805920]Preface 

In most of the engineering institutions, the  laboratory  course  forms  an  integral form of the basic course in Machine Design & CAD 1 at undergraduate level. The software to be used in the laboratory is AutoCAD 2015. The lab sessions to be performed in a laboratory should ideally be designed in such a way as to reinforce the understanding of the basic principles as well as help the students to visualize the various machines and objects in industrial applications. 
This lab manual of AutoCAD® 2015, offers a complete guide for students who want to enter the interesting world of computer-aided drafting using AutoCAD. This manual covers all aspects of the AutoCAD program’s 2D tools, from the basic concepts to the most powerful tools used in design and engineering.
The objective of this manual is  to  familiarize  the  students  with  topics and tasks, carefully grouped to lead students logically through the AutoCAD command set, with the level of difficulty increasing steadily as skills are acquired through experience and practice. It is intended to make this manual self-contained in all  respects,  so that  it  can  be  used  as  a  laboratory  manual.  In all the lab sessions, the relevant theory and general guidelines for the procedure to be followed have been given.
It is suggested that the students should complete the assigned task in the laboratory itself. The practices provided at the end of each experiment will reinforce the student’s understanding of the subject and also help them to prepare for viva-voce exams.










[bookmark: _Toc506805921]General Instructions to Students 
The following instructions should be strictly followed by the students in the Machine Design & Computer Aided Design & Drafting Laboratory
· The purpose of this laboratory is to reinforce and enhance your understanding of AutoCAD® 2015. The experiments here  are  designed  to  demonstrate  the  applications  of Machine Design to  provide  a  more  intuitive  and  physical  understanding  of  the theory. This laboratory exercise  also  provides  practice  in  making  engineering  judgments,  estimates  and assessing the reliability of your measurements, skills which are very important in all engineering disciplines. 
· Read the lab manual and any background material needed before you come to the lab.  You  must  be  prepared  for  your  experiments  before  coming  to  the  lab.  In many cases you may have to go back to your Machine Design textbooks to review the principles dealt with in the lab sessions.
· All the students are expected to complete their laboratory work.
· The students must save their files in the location specified by the Lab in Charge 
· Breakage amount will be collected from the student(s) for causing damage to the systems due to wrong operation or carelessness
· Computer System must be handled with care and the students must switch it on and off in the presence of Lab Technician only 
· Actively  participate  in  class  and  don’t  hesitate  to  ask  questions.  Utilize the teaching assistants. You should be well prepared before coming to the laboratory, unannounced questions may be asked at any time during the lab. 
· Carelessness in personal conduct or in handling equipment may result in serious injury to the individual or the equipment.  Always be on the alert for strange sounds. 
· Students must follow the proper dress code inside the laboratory. 
· Calculator and drawing accessories are mandatory. 
· Make your workplace clean before leaving the laboratory. Maintain silence, order and discipline inside the lab. 
· Cell phones are not allowed inside the laboratory. 
· Any injury no matter how small must be reported to the instructor immediately. 
· Wish you a nice lab session in this lab

iii
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	Experiment No.
	Description

	Lab Session 1
	Introduction to AutoCAD and learn the usage of Draw Tools like Polylines, Polygons, Circles, Arcs, lines, Splines, Donuts, Ellipse, etc. and construct different geometrical shapes

	Lab Session 2
	To construct a geometry using basic modify Tools like Erase, Copy, Move, Rotate, Scale, Align, Offset, Mirror, Stretch, Lengthen, Break, Trim, Extend, etc

	Lab Session 3
	Develop geometry of planar machine parts by using Advanced Editing Commands like Fillet, Chamfer, Array, Pedit, etc.

	Lab Session 4
	Draw the orthographic views of 3D machine parts and organizing your work by dimensioning, managing with layers and creating blocks in AutoCAD






[bookmark: _Toc441510147]

[bookmark: _Toc506805924]LAB SESSION 1
Introduction to AutoCAD and Learn the usage of Draw Tools like Polylines, Polygons, Circles, Arcs, lines, Splines, Donuts, Ellipse, etc. and construct different geometrical shapes

[bookmark: _Toc506805925]Learning Objective:
At the end of this study, the student will be able to use draw tools like Polylines, Polygons, Circles, Arcs, lines, Splines, Donuts, Ellipse, etc. and construct different geometrical shapes. 
[bookmark: _Toc441510149][bookmark: _Toc506805926]Apparatus
In order to complete the demonstration, we need a number of pieces of equipment. 
· Auto CAD Software
· Intel core i3 or above
· Compatible Microsoft Windows 
· Mouse or other pointing device
· CD-ROM drive

[bookmark: _Toc506805927]Introduction:
This lab manual will introduce students to the CAD software, AutoCAD 2015, which will be used for generating engineering drawings throughout this course. A brief overview of the software will be followed by introduction and practicing of some basic commands. This initial lab manual one of the most important manuals of this course because of the fact that the layout, and the environment of AutoCAD will be described here. Failing to understand the basics of the software will pose major problems for the students in future. It is once again emphasized that students should go through this manual carefully and understand each and every command or instruction presented herein.

[bookmark: _Toc506805928]Instructions:
1. Open AutoCAD 2015 by double clicking on its icon [image: ]situated somewhere on the desktop.

2. Change the view to AutoCAD Classis by choosing the appropriate option from the menu at the Quick Access Toolbar.
[image: ]

3. The following figure shows the workspace. Workspace is the area where a user can work.[image: ] The workspace is nothing but an XY Cartesian Plane. X-Axis (shown in Red) is the horizontal axis while Y-axis (shown in Green) is the vertical axis. Any location on this plane may accessed using XY coordinates of that location.

4. The following figure shows the command history (grey) and command input line (white) where the user may see the previous commands and enter various news commands through a keyboard. This command line can be used to access various tools, settings, preferences etc.[image: ]

5. Before starting any work certain settings should be checked and modified if necessary. The settings include the Coordinate Entry Settings, Units to be used, Grid size, Object Snaps etc.

a. Coordinate Entry Settings: AutoCAD allows the user to enter coordinates in two different ways. Absolute Coordinates are the coordinates relative to the WCS (World Coordinate System). The origin of the WCS is always located at the intersection of X- (Red) and Y-axis (Green). While when entering Incremental Coordinates the origin is always the last used point. Before moving on please change the Coordinate Entry setting by following the steps lists.
Go to settings (Drafting Settings) as shown in the following figure.[image: ]
Now in the Drafting Settings, go to Dynamic Input Tab and then click settings under the Pointer Input section. [image: ]
Make sure the settings are as shown in the following figure in the Pointer Input Settings.
[image: ]
b. Units: User can select from a variety of units to be used in his/her engineering drawing which he/she is going to produce using AutoCAD. In the Format menu, click Units to open ‘Drawing Units’ window.[image: ]
In the sections of Length and Angle, user can select the type of units and precision, while from the section of the Insertion Scale appropriate units may be selected.
c. Grid Size: The size of the grid shown in the workspace may be changed as per need. For this go to Drafting Settings and under the tab of Snap and Grid, a user may change grid spacing under the Grid Spacing section.[image: ]
d. Object Snap: Object snap options are very useful when working on drawing. These options are in fact aids for the user so that he/she can access certain points instantly. For example if the user want to access the end-point of a certain line and want the new line to start from this point, then he/she has to know exact coordinates of the point otherwise it won’t be possible for him/her to select exactly the required point. Object snap here helps the user by highlighting and attaching the cursor with the end-point if ‘end-point snap’ in turned on. User may turn on and off various snaps available from the tab of Object Snap in the [image: ]drafting settings.[image: ]
Along with the option of turning snaps on/off a symbol is also presented that will be shown when the cursor has been snapped to a particular object.


6. Once aforementioned settings have been understood, the user can now start drawing. This lab manual will include the introduction and use of the most basic commands that are used frequently when working with AutoCAD. Various drawing tools are available in the ‘Draw’ Toolbar 




[bookmark: _Toc506805929]DRAW TOOLBAR
[bookmark: _Toc506805930]Line:

The most basic tool is the Line Tool. User can activate this tool by clicking on its icon in the ‘Draw’ Toolbar, or by selecting it from the ‘Draw’ menu or by entering alphabet ‘l’ (ell) in the command line and pressing spacebar. Create a series of contiguous line segments. Each segment is a line object that can be edited separately.

Access Methods
Tool Set: Drafting tab > Draw panel > Line. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-12971FA0-B529-418C-80D0-B2FD66874C09.png]
Menu: Draw > Line.
With LINE, you can create a series of contiguous line segments. Each segment is a line object that can be edited separately.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-A21B3C8C-8C01-4FAC-BED0-7B79761C56BD.gif]
The following prompts are displayed.
Specify first point
Sets the starting point for the line. Click a point location. With object snaps or grid snap turned on, the points will be placed precisely. You can also enter coordinates. If instead, you press Enter at the prompt, a new line starts from the endpoint of the most recently created line, polyline, or arc. If the most recently created object is an arc, its endpoint defines the starting point of the line. The line is tangent to the arc.
Specify next point
Specifies the endpoint of the line segment. You can also use polar and object snap tracking together with direct distance entry.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-70729858-0332-4D21-9912-7555AE39457F.png]
Close
Connects the first and last segments.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-025E37CF-5FCE-4492-AE14-671619841EFF.png]
Undo
Removes the most recent segment of a line sequence.

[bookmark: _Toc506805931]Polyline: 
Creates a 2D polyline, a single object that is composed of line and arc segments.
Access Methods
Tool Set: Drafting tab > Draw panel > Polyline. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-30386B3B-BD89-447D-A95A-EFCE56889866.png]
Menu: Draw > Polyline.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-09D550C2-1DF8-47D5-A66E-8119CFF6D4A4.gif]
The following prompts are displayed.
Specify start point
Sets the starting point for the polyline.
· A temporary plus-shaped marker displays at the first point.
· Pressing Enter starts a new polyline from the last endpoint specified in creating a polyline, line, or arc.
Specify next point
· If you specify a second point, you create straight segments.
· If you enter a (for Arc), you create arc segments.
Prompts Common to Line and Arc Segments
Close
Connects the first and last segments to create a closed polyline.
Halfwidth
Specifies the width from the center of a wide segment to an edge.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-79424AA9-1596-4360-B969-7211826090CA.png]
Width
Specifies the width of the next segment.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-05976B64-17F4-4679-B249-2231506B6200.png]
Some things to keep in mind when defining the half-width or width of a polyline.
· The starting width becomes the default ending width.
· The ending width becomes the uniform width for all subsequent segments until you change the width again.
· The starting and ending points of wide line segments are at the centerline of the segment.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-FCF42104-1E00-4185-B48D-423F947F573F.png]
· Typically, the intersections of adjacent wide polyline segments are beveled.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-EAA852C0-D1B0-4252-8763-0AA160C85835.png]
· No beveling is performed for nontangent arc segments, very acute angles, or when a dot-dash linetype is used.
Undo
Removes the most recently added segment.



Line-Only Prompts
Arc
Begins creating arc segments tangent to the previous segment.
Length
Creates a segment of a specified length at the same angle as the previous segment. If the previous segment is an arc, the new line segment is tangent to that arc segment.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-545EFDBC-DE76-4EA3-B2C6-61B194CA2906.png]
Arc-Only Prompts
Endpoint of arc
Completes an arc segment. The arc segment is tangent to the previous segment of the polyline.
Angle
Specifies the included angle of the arc segment from the start point.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-AA3D3084-9DE8-4F89-8052-F006D8EF8A50.png]
Entering a positive number creates counterclockwise arc segments. Entering a negative number creates clockwise arc segments.
Center
Specifies an arc segment based on its center point.
Note: For the Center option of the PLINE command, enter ce; for the Center object snap, enter cen or center.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-3E63E085-C0ED-45BB-8ECD-CFEA47D8DA72.png]
Direction
Specifies the tangent for the arc segment.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-F6173CC0-631C-42D4-BC39-9C1650C31450.png]
· (2) Tangent direction from the start point of the arc. Specifies a point that establishes a tangency of the curve to the start point. The arc curves away from the vector between the start point and the tangent point.
· (3) Endpoint of the arc. Specifies the endpoint of the arc segment.
Tip: Press Ctrl to draw in a clockwise direction.
Line
Switches from drawing arc segments to drawing straight segments.
Radius
Specifies the radius of the arc segment.
Second pt
Specifies the second point and endpoint of a three-point arc.
Linetype Pattern
The PLINEGEN system variable controls how linetype patterns generate around the vertices of a 2D polyline.
· 0. Generates linetypes that start and end with a dash at each vertex of the polyline
· 1. Generates linetypes in an uninterrupted pattern through the vertices of the polyline
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-68E7FD4C-850A-460C-854D-BBAF85E4BEA4.png]
Note: Changing this value does not affect existing polylines. Change the Linetype Generation setting on the Properties palette to update existing polylines.

[bookmark: _Toc506805932]CIRCLE
This command is used to draw a Circle.
Access Methods
Type CIRCLE and press enter or C and press enter at “COMMAND:” prompt
Toolset: Drafting tab > Draw panel > Circle drop-down . [image: http://help.autodesk.com/cloudhelp/2017/ENU/AutoCAD-MAC-Core/images/GUID-7520F49C-B7B7-4285-8460-6FFC4EA34DF9.png]
Menu: Draw > Circle.
The following prompts are displayed.
Center Point
Creates a circle based on a center point and a radius or diameter value.
Radius [image: http://help.autodesk.com/cloudhelp/2017/ENU/AutoCAD-MAC-Core/images/GUID-7520F49C-B7B7-4285-8460-6FFC4EA34DF9.png]
Enter a value, or specify a point.
For example:
[image: http://help.autodesk.com/cloudhelp/2017/ENU/AutoCAD-MAC-Core/images/GUID-D00BF256-30FA-4BC7-B759-69ACB29579FD.gif]
Diameter [image: http://help.autodesk.com/cloudhelp/2017/ENU/AutoCAD-MAC-Core/images/GUID-CEE736F3-2FDE-466D-8A62-767EED3B741F.png]
Enter a value, or specify a second point.
For example:
[image: http://help.autodesk.com/cloudhelp/2017/ENU/AutoCAD-MAC-Core/images/GUID-4DFD8BC3-5653-4D0F-A9BE-C1DE5744788E.gif]
3P (Three Points) [image: http://help.autodesk.com/cloudhelp/2017/ENU/AutoCAD-MAC-Core/images/GUID-987F17B7-B898-4AEC-BE74-66668352AB28.png]
Creates a circle based on three points on the circumference.
For example:
[image: http://help.autodesk.com/cloudhelp/2017/ENU/AutoCAD-MAC-Core/images/GUID-D259A90A-4761-4169-A3FF-E60746726414.gif]
Tan, Tan, Tan [image: http://help.autodesk.com/cloudhelp/2017/ENU/AutoCAD-MAC-Core/images/GUID-1957EB8D-A922-4B0A-A74E-7F67D7593409.png]
Creates a circle tangent to three objects.
For example:
[image: http://help.autodesk.com/cloudhelp/2017/ENU/AutoCAD-MAC-Core/images/GUID-092D1700-7089-445A-BB58-E55DE6173C15.gif]
2P (Two Points) [image: http://help.autodesk.com/cloudhelp/2017/ENU/AutoCAD-MAC-Core/images/GUID-13191C2B-3C7B-483A-A434-7500AE7383BD.png]
Creates a circle based on two endpoints of the diameter.
For example:
[image: http://help.autodesk.com/cloudhelp/2017/ENU/AutoCAD-MAC-Core/images/GUID-E6001089-0358-48F3-8632-0B1599B0859D.gif]
TTR (Tangent, Tangent, Radius) [image: http://help.autodesk.com/cloudhelp/2017/ENU/AutoCAD-MAC-Core/images/GUID-099AE5F3-6138-4FEE-89E8-6FA82676729E.png]
Creates a circle with a specified radius and tangent to two objects.
Sometimes more than one circle matches the specified criteria. The program draws the circle of the specified radius whose tangent points are closest to the selected points.
For example:
[image: http://help.autodesk.com/cloudhelp/2017/ENU/AutoCAD-MAC-Core/images/GUID-50A1C9A9-664C-4DC7-ACA9-55C54A1BC27A.gif]
[bookmark: _Toc506805933]ARC:
This tool will allow you to create arcs all the way up to 360 degrees
Access Methods
Tool Set: Drafting tab > Draw panel > Arc drop-down. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-6E1BE1CC-A3C0-4FD0-A44D-8A242CAF780B.png]
Menu: Draw > Arc.
To create an arc, you can specify combinations of center, endpoint, start point, radius, angle, chord length, and direction values. Arcs are drawn in a counterclockwise direction by default. Hold down the Ctrl key as you drag to draw in a clockwise direction.
The following prompts are displayed.
Start point
Draws an arc using three specified points on the arc's circumference. The first point is the start point (1).
Second point [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-6E1BE1CC-A3C0-4FD0-A44D-8A242CAF780B.png]
Specify the second point (2) is a point on the circumference of the arc.
End point
Specify the final point (3) on the arc.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-2A34A0C9-F6C1-4CDC-BDEA-9478814FE594.gif]
You can specify a three-point arc either clockwise or counterclockwise.
Center
Specify the second point (2) is the center of the circle of which the arc is a part.
End point [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-2151E970-19A0-4BEE-96B2-9106687A191C.png]
Using the center point (2), draws an arc counterclockwise from the start point (1) to an endpoint that falls on an imaginary ray drawn from the center point through the third point (3).
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-BD4CB9A6-7351-45F0-8FFF-25184E21B135.png]
The arc does not necessarily pass through this third point, as shown in the illustration.
The distance between the start point and the center determines the radius. The endpoint is determined by a line from the center that passes through the third point.
Angle [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-184A5A2B-C1A5-42BA-8F32-44479C0CAEC5.png]
The distance between the start point and the center determines the radius. The other end of the arc is determined by specifying an included angle that uses the center of the arc as the vertex.
If the angle is negative, a clockwise arc is drawn.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-BDE30960-CAF7-4185-9B42-19E9E617C505.gif]
Chord length [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-76E3BE2E-3449-4DEB-B26B-1FFD211AB7CF.png]
Draws either a minor or a major arc based on the distance of a straight line between the start point and endpoint.
If the chord length is positive, the minor arc is drawn counterclockwise from the start point. If the chord length is negative, the major arc is drawn counterclockwise.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-29C010C8-31F1-449A-B6FF-24EC51CB9709.png]
End
Specify the second point (2) is the endpoint of the arc.
Center point
Draws an arc counterclockwise from the start point (1) to an endpoint that falls on an imaginary ray drawn from the center point (3) through the second point specified (2).
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-01916CF6-B07D-46AB-B34D-C9BF7FC2249B.png]
Angle [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-52402C2F-AE74-46CC-8055-7CBF4D35AD92.png]
Draws an arc counterclockwise from the start point (1) to an endpoint (2), with a specified included angle. Specify the second point (2) is the endpoint of the arc. If the angle is negative, a clockwise arc is drawn.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-DB2A2332-5726-4631-B004-3F6AEE520051.png]
Direction [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-68BBDD98-B508-453B-AFDB-BE17CE8386D1.png]
Begins the arc tangent to a specified direction. It creates any arc, major or minor, clockwise or counterclockwise, beginning with the start point (1), and ending at an endpoint (2). The direction is determined from the start point.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-C0BA5D07-826D-49E3-9A01-B0EF15F95696.png]
Radius [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-9C1C5369-8399-4925-82AB-4F6D8609AED3.png]
Draws the minor arc counterclockwise from the start point (1) to the endpoint (2). If the radius is negative, the major arc is drawn.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-D047C140-11D6-42A0-BE70-285E4E840032.png]

Center
Starts by specifying the center of the circle of which the arc is a part.
Start point
Specify start point of arc.
End point [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-1FDD8A3B-7EFE-49FE-A1E3-A50C89DF27E3.png]
Draws an arc counterclockwise from the start point (2) to an endpoint that falls on an imaginary ray drawn from the center point (1) through a specified point (3).
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-BD4CB9A6-7351-45F0-8FFF-25184E21B135.png]
Angle [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-434190A0-1015-4EB7-BDE5-091C4F43D871.png]
Draws an arc counterclockwise from the start point (2) using a center point (1) with a specified included angle. If the angle is negative, a clockwise arc is drawn.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-C125C3C5-B716-4904-AAEE-92B19BCCFF2F.png]
Chord length [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-8891AE6A-7AA3-4F91-81A8-68BD9E6C8EEB.png]
Draws either a minor or a major arc based on the distance of a straight line between the start point and endpoint.
If the chord length is positive, the minor arc is drawn counterclockwise from the start point. If the chord length is negative, the major arc is drawn counterclockwise.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-29C010C8-31F1-449A-B6FF-24EC51CB9709.png]

Tangent to last line, arc, or polyline [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-2A5192E6-DF4D-40F2-911A-07CC8F84F904.png]
Immediately after you create a line or an arc, you can start an arc that is tangent at an endpoint by starting the ARC command and pressing ENTER at the Specify Start Point prompt. You need to specify only the endpoint of the arc.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-025E08EE-CB38-4515-B06F-DBB7BFF2AB9D.gif]
End point of arc
Specify a point (1).
[bookmark: _Toc506805934]Rectangle
Creates a rectangular polyline.
Access Methods
Toolset: Drafting tab > Draw panel > Rectangle . [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-401CD2F1-D8EB-469A-BD1C-5E2C96D4E5AB.png]
Menu: Draw > Rectangle.
Creates a rectangular polyline from the specified the rectangle parameters (length, width, rotation) and type of corners (fillet, chamfer, or square).
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-B164447B-D4F6-4AEB-A428-3CC4BF48E69B.gif]
The following prompts are displayed.
Current settings: Rotation = 0
Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: Specify a point or enter an option
First Corner Point
Specifies a corner point of the rectangle.
Other Corner Point
Creates a rectangle using the specified points as diagonally opposite corners.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-CBB4BE31-AFBB-4A2F-9BBC-55AE4B384632.png]
Area
Creates a rectangle using the area and either a length or a width. If the Chamfer or Fillet option is active, the area includes the effect of the chamfers or fillets on the corners of the rectangle.
Dimensions
Creates a rectangle using length and width values.
Rotation
Creates a rectangle at a specified rotation angle.
Chamfer
Sets the chamfer distances for the rectangle.
Elevation
Specifies the elevation of the rectangle.
Fillet
Specifies the fillet radius of the rectangle.
Thickness
Specifies the thickness of the rectangle.

Width
Specifies the polyline width of the rectangle to be drawn.
[bookmark: _Toc506805935]POLYGON
Creates an equilateral closed polyline.
Access Methods
Tool Set: Drafting tab > Draw panel > Rectangle drop-down > Polygon. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-B4E2434C-55AA-4D6F-AA57-33F01CA9297F.png]
Menu: Draw > Polygon.
You specify the number of sides of the polygon and whether it is inscribed or circumscribed.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-E7DD429C-0E78-46C5-818F-20E1A1A0410D.gif]
The following prompts are displayed.
Number of sides
Specifies the number of sides in the polygon (3-1024).
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-B25D69A7-4B73-478F-BC7F-CB6049DDCF2B.png]
Center of polygon
Specifies the location of the center of the polygon and whether the new object is inscribed or circumscribed.
Inscribed in circle
Specifies the radius of a circle on which all vertices of the polygon lie.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-B4A7CFFF-87F0-4E58-80DA-5198F2C37285.png]
Specifying the radius with your pointing device determines the rotation and size of the polygon. Specifying the radius with a value draws the bottom edge of the polygon at the current snap rotation angle.
Circumscribed about circle
Specifies the distance from the center of the polygon to the midpoints of the edges of the polygon.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-8B47B711-603C-4B58-96D6-33F234F65061.png]
Specifying the radius with your pointing device determines the rotation and size of the polygon. Specifying the radius with a value draws the bottom edge of the polygon at the current snap rotation angle.
Edge
Defines a polygon by specifying the endpoints of the first edge.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-30D66346-D5A5-4E1B-9D95-BA89F98C7D1D.png]

[bookmark: _Toc506805936]Ellipse:
Creates an ellipse or an elliptical arc.
Access Methods
Tool Set: Drafting tab > Draw panel > Ellipse drop-down. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-F951194A-4DD8-45A0-AD79-83F1BC690AA4.png]
Menu: Draw > Ellipse.
The first two points of the ellipse determine the location and length of the first axis. The third point determines the distance between the center of the ellipse and the end point of the second axis.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-5C6E641E-9DE7-4284-9AB0-F3A000DEE6A6.gif]
The following prompts are displayed.
Axis Endpoint [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-36ACD897-212E-469F-96D1-0FF1356A0DA3.png]
Defines the first axis by its two endpoints. The angle of the first axis determines the angle of the ellipse. The first axis can define either the major or the minor axis of the ellipse.
Distance to Other Axis
Defines the second axis using the distance from the midpoint of the first axis to the endpoint of the second axis (3).
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-ED50BE97-AE70-4B2C-BD3B-92FC31AC6E04.png]
Rotation
Creates the ellipse by appearing to rotate a circle about the first axis.
Move the crosshairs around the center of the ellipse and click. If you enter a value, the higher the value, the greater the eccentricity of the ellipse. Entering 0 defines a circular ellipse.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-63F63990-9C88-408A-91C7-F0D5F53D0473.png]
Arc [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-EC200F6F-5C85-4482-A84B-16AAE01A3ED5.png]
Creates an elliptical arc.
The angle of the first axis determines the angle of the elliptical arc. The first axis can define either the major or the minor axis depending on its size.
The first two points of the elliptical arc determine the location and length of the first axis. The third point determines the distance between the center of the elliptical arc and the endpoint of the second axis. The fourth and fifth points are the start and end angles.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-504F8DE2-AEB9-4BE8-8497-C8F16335297A.gif]
Axis Endpoint
Defines the start point of the first axis.
Rotation
Defines the major to minor axis ratio of the ellipse by rotating a circle about the first axis. The higher the value from 0 through 89.4 degrees, the greater the ratio of minor to major axis. Values between 89.4 degrees and 90.6 degrees are invalid because the ellipse would otherwise appear as a straight line. Multiples of these angle values result in a mirrored effect every 90 degrees.
Start Angle
Defines the first endpoint of the elliptical arc. The Start Angle option also changes Parameter mode to Angle mode. The mode controls how the ellipse is calculated.
Parameter (specialized option)
Requires angular input, but creates the elliptical arc using the following parametric vector equation for the angle of each endpoint:
p(angle) = c + a * cos(angle) + b * sin(angle)
where c is the center of the ellipse and a and b are the negative lengths of its major and minor axes, respectively.
· End Parameter: Defines the end angle of the elliptical arc by using a parametric vector equation. The Start Parameter option toggles from Angle mode to Parameter mode. The mode controls how the ellipse is calculated.
· Angle: Defines the end angle of the elliptical arc. The Angle option toggles from Parameter mode to Angle mode. The mode controls how the ellipse is calculated.
· Included Angle: Defines an included angle beginning at the start angle.
Center [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-F951194A-4DD8-45A0-AD79-83F1BC690AA4.png]
Creates an ellipse using a center point, the endpoint of the first axis, and the length of the second axis. You can specify the distances by clicking a location at the desired distance or by entering a value for the length.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-BA30F87E-379A-451A-9E98-45989609B02A.gif]
Distance to Other Axis
Defines the second axis as the distance from the center of the ellipse, or midpoint of the first axis, to the point you specify.
Rotation
Creates the ellipse by appearing to rotate a circle about the first axis.
Move the crosshairs around the center of the ellipse and click. If you enter a value, the higher the value, the greater the eccentricity of the ellipse. Entering 0 defines a circle.
Isocircle
Creates an isometric circle in the current isometric drawing plane.
Note: The Isocircle option is available only when ISODRAFT is set to an isoplane, or the Style option of SNAP is set to Isometric.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-75DF9B04-5B0A-4943-B18D-F5773DAC825D.png]
Radius
Creates an isometric representation of a circle using a radius you specify.
Diameter
Creates an isometric representation of a circle using a diameter you specify.
[bookmark: _Toc506805937]Hatch:
Fills an enclosed area or selected objects with a hatch pattern, solid fill, or gradient fill.
Access Methods
[image: http://help.autodesk.com/cloudhelp/2016/ENU/AutoCAD-MAC-Core/images/GUID-FD9EF548-315D-4C83-BEE7-1AB171465EEF.png]
Button
[image: http://help.autodesk.com/cloudhelp/2016/ENU/AutoCAD-MAC-Core/images/ac.mouse.gif]  Toolbar: Drafting tool set [image: http://help.autodesk.com/cloudhelp/2016/ENU/AutoCAD-MAC-Core/images/ac.menuaro.gif] Closed Shapes tool group [image: http://help.autodesk.com/cloudhelp/2016/ENU/AutoCAD-MAC-Core/images/ac.menuaro.gif] Hatch
[image: http://help.autodesk.com/cloudhelp/2016/ENU/AutoCAD-MAC-Core/images/ac.mouse.gif]  Menu:  Draw [image: http://help.autodesk.com/cloudhelp/2016/ENU/AutoCAD-MAC-Core/images/ac.menuaro.gif] Hatch
Summary
The Hatch visor or Hatch and Gradient dialog box is displayed.
If you enter -hatch at the Command prompt, options are displayed.
Note: To prevent the creation of an enormous number of hatch lines, the maximum number of hatch lines created in a single hatch operation is limited. This limit prevents memory and performance problems. However, you can change the maximum number of hatch lines with the HPMAXLINES system variable.
Choose from several methods to specify the boundaries of a hatch.
· Specify a point in an area that is enclosed by objects.
· Select objects that enclose an area.
· Specify boundary points using the -HATCH Draw option.
[image: http://help.autodesk.com/cloudhelp/2016/ENU/AutoCAD-MAC-Core/images/GUID-10BB1476-0D26-41F7-824E-14B5013ACCB6.gif]

[bookmark: _Toc506805938]Gradient: 
Fills an enclosed area or selected objects with a gradient fill.
Access Methods
Tool Set: Drafting tab > Hatch panel > Gradient. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-A66B46E4-F1A0-426A-9664-5305AFD11A61.png]
Menu: Draw > Gradient.
The Gradient visor or Hatch and Gradient dialog box is displayed. If you prefer using the Hatch and Gradient dialog box, set the HPDLGMODE system variable to 1.
A gradient fill creates a smooth transition between one or two colors.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-D133EF67-6E67-44DC-8CE4-A3B5F9B90FD6.gif]

[bookmark: _Toc506805939]Boundary:
Creates a region or a polyline from an enclosed area.
Access Methods
Tool Set: Drafting tab > Hatch panel > Boundary. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-D54FC086-4D7A-4EAA-8243-41FF6509F5EC.png]
Menu: Draw > Boundary.
The Boundary Creation dialog box is displayed.
If you enter -boundary at the Command prompt, options are displayed.
Each point that you specify identifies the surrounding objects and creates a separate region or polyline.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-980F7CDE-30B1-4B3D-BB8E-69C6D0C35A4A.gif]



[bookmark: _Toc506805940]Donut:
Creates a filled circle or a wide ring.
Access Methods
Tool Set: Drafting tab > Draw panel > Donut. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-CFEBBE80-DA08-4094-8650-EA70BA259027.png]
Note: Hidden by default. Click [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-78DED619-51B3-49C1-AD71-F928B5F69C0A.png] to display the icon on the tool set panel.
Menu: Draw > Donut.
A donut consists of two arc polylines that are joined end-to-end to create a circular shape. The width of the polylines is determined by the specified inside and outside diameters. If you specify an inside diameter of 0, the donut is a filled circle.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-C260D806-EE68-45E1-9326-B077BC487A0C.gif]
The following prompts are displayed.
Inside Diameter
Specifies the inside diameter of the donut as shown.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-40FEB73F-075E-40D8-9005-1A74B89A2B13.png]
Outside Diameter
Specifies the outside diameter of the donut.
Center of Donut
Specifies the location of the donut based on its center point. A donut is drawn at each point specified until you press Enter to end the command.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-6A8FFF9C-8F92-4C1D-9424-CC010EA8AA37.png]


[bookmark: _Toc506805941]LAB SESSION 2
To construct a geometry using basic modify Tools like Erase, Copy, Move, Rotate, Scale, Align, Offset, Mirror, Stretch, Lengthen, Break, Trim, Extend, etc

[bookmark: _Toc506805942]Learning Objective:
At the end of this study, the student will be able to construct a geometry using basic modify Tools like Erase, Copy, Move, Rotate, Scale, Align, Offset, Mirror, Stretch, Lengthen, Break, Trim, Extend. 
[bookmark: _Toc506805943]Apparatus
In order to complete the demonstration, we need a equipment. 
· Auto CAD Software
· Intel core i3 or above
· Compatible Microsoft Windows 
· Mouse or other pointing device
· CD-ROM drive

[bookmark: _Toc506805944]Introduction:
This lab manual will introduce students to some basic modifying commands which will aid the user to generate some complex geometric shape and engineering drawing. Students shall learn to use basic modifying commands to create complex geometric shapes and generate their first orthographic projection of a simple engineering part using first-angle projection method.

[bookmark: _Toc506805945]Instructions:
1. Open AutoCAD 2015 by double clicking on its icon [image: ]situated somewhere on the desktop.
2. Change the view to AutoCAD Classis by choosing the appropriate option from the menu at the Quick Access Toolbar.
3. Ortho Lines: Activate the Line tool and press F8 or click the ‘Ortho Mode’ button in the status bar.
 [image: ]

Now line tool can only draw orthogonal lines, i.e. vertical and horizontal. This mode is activated when the user wants to work with orthogonal lines only. Normally this mode is used with the movement of cursor and entering only the length of the line to be drawn.
For example, specify a starting point for a line and then move the cursor towards the positive x-direction from this point and enter only the length of the line to be drawn. A perfect horizontal line would be drawn of the given length. From this point onwards move the cursor in positive y-direction and enter the length of the line to be drawn. A perfect vertical line will be drawn of the specified length.

[bookmark: _Toc506805946]MODIFY TOOLBAR
[bookmark: _Toc506805947]MOVE
Moves objects a specified distance in a specified direction.
Access Methods
Tool Set: Drafting tab > Modify panel > Move. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-DE17DBB8-D05E-46A6-A54D-BF9B6E37D8BC.png]
Menu: Modify > Move.
Use coordinates, grid snaps, object snaps, and other tools to move objects with precision.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-8E16722D-DD4A-4BBA-9780-FDB0E3B077B2.gif]
The following prompts are displayed.
Select objects
Specifies which objects to move.
Base point
Specifies the start point for the move.
Second point
In combination with the first point, specifies a vector that indicates how far, and in what direction, the selected objects are moved.
If you press Enter to accept the Use first point as displacement value, the first point is interpreted as a relative X,Y,Z displacement. For example, if you specify 2,3 for the base point and press Enter at the next prompt, the objects move 2 units in the X direction and 3 units in the Y direction from their current position.
Displacement
Specifies a relative distance and direction.
The two points you specify define a vector that indicates how far from the original the copied objects are to be placed and in what direction.
[bookmark: _Toc506805948]ROTATE
Rotates objects around a base point.
Access Methods
Tool Set: Drafting tab > Modify panel > Rotate. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-4242A500-067F-4CF7-9EF8-F633D1E9D997.png]
Menu: Modify > Rotate.
You can rotate selected objects around a base point to an absolute angle.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-1EFC6739-5710-4688-8A78-1D7EF8BF1352.gif]
The following prompts are displayed.
Select objects
Use an object selection method and press Enter when you finish.
Specify base point
Specify a point.
Specify rotation angle
Enter an angle, specify a point, enter c , or enter r.
· Rotation Angle. Determines how far an object rotates around the base point. The axis of rotation passes through the specified base point and is parallel to the Z axis of the current UCS.
· Copy. Creates a copy of the selected objects for rotation.
· Reference. Rotates objects from a specified angle to a new, absolute angle. When you rotate a viewport object, the borders of the viewport remain parallel to the edges of the drawing area.


[bookmark: _Toc506805949]ERASE
Removes objects from a drawing.
Access Methods
Tool Set: Drafting tab > Modify panel > Erase. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-342B2C46-0E0A-431A-829D-77901015ED51.png]
Menu: Modify > Erase.
You can erase selected objects from the drawing. This method does not move objects to the Clipboard, where they can then be pasted to another location.
If you are working with 3D objects, you can also erase subobjects such as faces, meshes, and vertices.
Instead of selecting objects to erase, you can enter an option, such as L to erase the last object drawn, p to erase the previous selection set, or ALL to erase all objects. You can also enter ? to get a list of all options.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-57AABC27-7269-486E-BE37-55FA98247C6E.gif]
[bookmark: _Toc506805950]COPY
Copies objects a specified distance in a specified direction.
Access Methods
Tool Set: Drafting tab > Modify panel > Copy. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-3FFF159C-9CD3-4A0C-AC82-E712A515ED3A.png]
Menu: Modify > Copy.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-FEEBE4B9-0DE3-4555-9F12-C2C2FDDD322A.png]
With the COPYMODE system variable, you can control whether multiple copies are created automatically.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-7A9EC2F4-4552-491C-BED9-EA8C1CED533F.gif]
The following prompts are displayed.
Select objects: Use an object selection method and press Enter when you finish
Specify base point or [Displacement/mOde/Multiple] <Displacement>: Specify a base point or enter an option
Specify second point or [Array] <use first point as displacement>: Specify a second point or enter an option

Displacement
Specifies a relative distance and direction using coordinates.
The two points you specify define a vector that indicates how far from the original the copied objects are to be placed and in what direction.
If you press Enter at the Specify Second Point prompt, the first point is interpreted as a relative X,Y,Z displacement. For example, if you specify 2,3 for the base point and press Enter at the next prompt, the objects are copied 2 units in the X direction and 3 units in the Y direction from their current location.
Mode
Controls whether the command repeats automatically (COPYMODE system variable).
Single
Creates a single copy of selected objects and ends the command.
Multiple
Overrides the Single mode setting. The COPY command is set to repeat automatically for the duration of the command.
Array
Arranges a specified number of copies in a linear array.
Number of Items to Array
Specifies the number of items in the array, including the original selection set.
Second Point
Determines a distance and direction for the array relative to the base point. By default, the first copy in the array is positioned at the specified displacement. The remaining copies are positioned in a linear array beyond that point using the same incremental displacement.
Fit
Positions the final copy in the array at the specified displacement. The other copies are fit in a linear array between the original selection set and the final copy.

Fit
Redefines the array to use the specified displacement as the location of the last copy rather than the first copy, fitting the other copies between the original selection set and the final copy.
[bookmark: _Toc506805951]SCALE
Enlarges or reduces selected objects, keeping the proportions of the object the same after scaling.
Access Methods
Tool Set: Drafting tab > Modify panel > Scale. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-2E69AFE3-06D8-4B6B-AFAE-C8CB3FB009E8.png]
Menu: Modify > Scale.
To scale an object, specify a base point and a scale factor. The base point acts as the center of the scaling operation and remains stationary. A scale factor greater than 1 enlarges the object. A scale factor between 0 and 1 shrinks the object.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-9BB2D0ED-8B1F-4FA6-B3BB-36D8D7287FE8.gif]
The following prompts are displayed.
Select objects
Specifies which objects you want to resize.
Base point
Specify a base point for the scale operation.
The base point you specify identifies the point that remains in the same location as the selected objects change size (and thus move away from the stationary base point).
Note: When you use the SCALE command with annotative objects, the position or location of the object is scaled relative to the base point of the scale operation, but the size of the object is not changed.
Scale Factor
Multiplies the dimensions of the selected objects by the specified scale. A scale factor greater than 1 enlarges the objects. A scale factor between 0 and 1 shrinks the objects. You can also drag the cursor to make the object larger or smaller.
Copy
Creates a copy of the selected objects for scaling.
Reference
Scales the selected objects based on a reference length and a specified new length.
[bookmark: _Toc506805952]ALIGN
Aligns objects with other objects in 2D and 3D.
Access Methods
Tool Sets: Drafting tab > Modify panel > Align. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-E8A89848-B847-4C63-B8F0-7FDC4925AD9A.png]
Note: Hidden by default. Click [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-78DED619-51B3-49C1-AD71-F928B5F69C0A.png] to display the icon on the tool set panel.
Menu: Modify > 3D Operations > Align.
Either one, two, or three pairs of source points and definition points can be specified to move, rotate, or tilt the selected objects, aligning them with points on another object.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-E85DF25C-AEB9-4B5A-86E2-6A95B54A65F9.gif]
The following prompts are displayed.
Select objects
Select the objects to align and press Enter.
The next series of prompts asks for source and destination points. The number of point pairs that you specify determines the results.
First source point, First destination point
When you select only one source point and destination point pair, the selected objects move in 2D or 3D from the source point (1) to the destination point (2).
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-EFDA2C49-6DF9-41DC-ABB6-77D1BA8C8AFD.png]
First and Second source and destination points
When you select two point pairs, you can move, rotate, and scale the selected objects to align with other objects.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-5CA0489D-9C17-42FD-8902-2EC2229A7F5D.png]
The first set of source and destination points defines the base point for the alignment (1, 2). The second set of points defines the angle of rotation (3, 4).
After you enter the second set of points, you are prompted to scale the object. The distance between the first and second destination points (2, 4) is used as the reference length to which the object is scaled. Scaling is available only when you are aligning objects using two point pairs.
Note: If you use two source and destination points to perform a 3D alignment on non-perpendicular working planes, you get unpredictable results.
[bookmark: _Toc506805953]OFFSET
Creates concentric circles, parallel lines, and parallel curves.
Access Methods
Tool Set: Drafting tab > Modify panel > Offset. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-9F7D4463-198A-410F-8D3A-591E48B9288E.png]
Menu: Modify > Offset.
You can offset an object at a specified distance or through a point. After you offset objects, you can trim and extend them as an efficient method to create drawings containing many parallel lines and curves.
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The OFFSET command repeats for convenience. To exit the command, press Enter.
The following prompts are displayed.
Offset Distance
Creates an object at a specified distance from an existing object.
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Exit
Exits the OFFSET command.
Multiple
Enters the Multiple offset mode, which repeats the offset operation using the current offset distance.
Undo
Reverses the previous offset.
Through
Creates an object passing through a specified point.
Note: For best results when you offset a polyline with corners, specify the through point near the midpoint of a line segment, not near a corner.
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· Exit
· Multiple
· Undo
Erase
Erases the source object after it is offset.
Layer
Determines whether offset objects are created on the current layer or on the layer of the source object.
[bookmark: _Toc506805954]MIRROR
Creates a mirrored copy of selected objects.
Access Methods
Tool Set: Drafting tab > Modify panel > Mirror. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-D688E1AF-F7AB-4F1D-B29B-93F48BE3CC25.png]
Menu: Modify > Mirror.
You can create objects that represent half of a drawing, select them, and mirror them across a specified line to create the other half.
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Note: By default, when you mirror a text object, the direction of the text is not changed. Set the MIRRTEXT system variable to 1 if you do want the text to be reversed.
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The following prompts are displayed.
Select objects
Use an object selection method to select the objects to be mirrored. Press Enter to finish.
Specify first point, second point of mirror line
The two specified points become the endpoints of a line about which the selected objects are mirrored. For mirroring in 3D, this line defines a mirroring plane perpendicular to the XY plane of the user coordinate system (UCS) containing the mirror line.
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Erase source objects
Determines whether the original objects are erased or retained after mirroring them.
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[bookmark: _Toc506805955]STRETCH
Stretches objects crossed by a selection window or polygon.
Access Methods
Tool Set: Drafting tab > Modify panel > Stretch. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-9C413D4F-E14A-425C-AC00-CAABC1582429.png]
Menu: Modify > Stretch.
Objects that are partially enclosed by a crossing window are stretched. Objects that are completely enclosed within the crossing window, or that are selected individually, are moved rather than stretched. Some types of objects such as circles, ellipses, and blocks, cannot be stretched.
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The following prompts are displayed.
Select objects
Specifies the portion of the object that you want to stretch. Use the cpolygon option or the crossing object selection method. Press Enter when the selection is complete.
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STRETCH moves only the vertices and endpoints that lie inside the crossing selection, leaving those outside unchanged. STRETCH does not modify 3D solids, polyline width, tangent, or curve-fitting information.
Base Point
Specifies the base point from which the offset for the stretch is calculated. This base point can be outside the area being stretched.
Second point
Specifies a second point that defines the distance and direction of the stretch. The distance and direction of this point from the base point defines how far the and in what direction the selected portions of the object will be stretched.
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Use first point as displacement
Specifies that the stretch distance and direction will be based on the distance and direction of the base point you specified from the 0,0,0 coordinates in the drawing.
Displacement
Specifies the relative distance and direction of the stretch.
· To set a displacement based on the relative distance from the current location, enter distances in X,Y, Z format. For example, enter 5,4,0 to stretch the selection to a point that is 5 units along the X axis and 4 units along the Y axis from the original point.
· To set the displacement based on the distance and direction from the 0,0,0 coordinates in the drawing, click a location in the drawing area. For example, click a point at 1,2,0 to stretch the selection to a point that is 1 unit along the X axis and 2 units along the Y axis from its current location.

[bookmark: _Toc506805956]LENGTHEN
Changes the length of objects and the included angle of arcs.
Access Methods
Tool Sets: Drafting tab > Modify panel > Lengthen. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-E835CDF6-D2B4-4965-87FD-E6841924D37D.png]
Note: Hidden by default. Click [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-78DED619-51B3-49C1-AD71-F928B5F69C0A.png] to display the icon on the tool set panel.
Menu: Modify > Lengthen.
You can specify changes as a percentage, an increment, or as a final length or angle. LENGTHEN is an alternative to using TRIM or EXTEND.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-032BCDA0-D320-4AD9-90F6-0F702E8013E2.gif]
The following prompts are displayed.
Object Selection
Displays the length and, where applicable, the included angle of the object.
LENGTHEN does not affect closed objects. The extrusion direction of the selected object need not be parallel to the Z axis of the current user coordinate system (UCS).
Delta
Changes the length of an object by a specified increment, measured from the endpoint that is closest to the selection point. Delta also changes the angle of an arc by a specified increment, measured from the endpoint that is closest to the selection point. A positive value extends the object; a negative value trims it.
Delta Length
Changes the length of the object by the specified increment.
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Angle
Changes the included angle of the selected arc by the specified angle.
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Percent
Sets the length of an object by a specified percentage of its total length.
Total
Sets the length of a selected object by specifying the total absolute length from the fixed endpoint. Total also sets the included angle of a selected arc by a specified total angle.
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Total Length
Lengthens the object to the specified value from the endpoint that is closest to the selection point.
Angle
Sets the included angle of the selected arc.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-969A7B3C-E5B0-4432-A841-1ABD03F817D9.png]
Dynamic
Turns on Dynamic Dragging mode. You change the length of a selected object by dragging one of its endpoints. The other end remains fixed.

[bookmark: _Toc506805957]BREAK
Breaks the selected object between two points.
Access Methods
Tool Set: Drafting tab > Modify panel > Break drop-down > Break. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-80FF8BCE-417E-49B8-B945-3EE246031EC0.png]
Tool Set: Drafting tab > Modify panel > Break drop-down > Break at Point. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-6FD61209-7835-4DA3-9F54-EE2F3ADB87D5.png]
Menu: Modify > Break.
You can create a gap between two specified points on an object, breaking it into two objects. If the points are off of an object, they are automatically projected on to the object. BREAK is often used to create space for a block or text.
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The prompts that are displayed depend on how you select the object. If you select the object by using your pointing device, the program both selects the object and treats the selection point as the first break point. At the next prompt, you can continue by specifying the second point or by overriding the first point.
First point
Overrides the original first point where you selected the object with a new point that you specify.
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Second point
Specifies a second point. The portion of the object is erased between the two points that you specify. If the second point is not on the object, the nearest point on the object is selected; therefore, to break off one end of a line, arc, or polyline, specify the second point beyond the end to be removed.
To split an object in two without erasing a portion, enter the same point for both the first and second points. You can do this by entering @ to specify the second point.
Lines, arcs, circles, polylines, ellipses, splines, donuts, and several other object types can be split into two objects or have one end removed.
The program converts a circle to an arc by removing a piece of the circle starting counterclockwise from the first to the second point.
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You can also break selected objects at a single point with the Break at Point tool.
Valid objects include lines, open polylines, and arcs. Closed objects such as circles cannot be broken at a single point.
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[bookmark: _Toc506805958]TRIM
Trims objects to meet the edges of other objects.
Access Methods
Tool Set: Drafting tab > Modify panel > Trim. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-53B8A7B8-0050-44CA-A923-870AF64E125A.png]
Menu: Modify > Trim.
To trim objects, select the boundaries and press Enter. Then select the objects that you want to trim. To use all objects as boundaries, press Enter at the first Select Objects prompt.
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The following prompts are displayed.
Select cutting edges
Specifies one or more objects to be used as a boundary for the trim. TRIM projects the cutting edges and the objects to be trimmed onto the XY plane of the current user coordinate system (UCS).
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Note: To select cutting edges that include blocks, you can use only the single selection, Crossing, Fence, and Select All options.
Select objects
Specifies objects individually.
Select all
Specifies that all objects in the drawing can be used as a trim boundary.
Object to Trim
Specifies the object to trim. If more than one trim result is possible, the location of the first selection point determines the result.
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Shift-Select to Extend
Extends the selected objects rather than trimming them. This option provides an easy method to switch between trimming and extending.
Fence
Selects all objects that cross the selection fence. The selection fence is a series of temporary line segments that you specify with two or more fence points. The selection fence does not form a closed loop.
Crossing
Selects objects within and crossing a rectangular area defined by two points.
Note: Some crossing selections of objects to be trimmed are ambiguous. TRIM resolves the selection by following along the rectangular crossing window in a clockwise direction from the first point to the first object encountered.
Project
Specifies the projection method used when trimming objects.
None
Specifies no projection. The command trims only objects that intersect with the cutting edge in 3D space.
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UCS
Specifies projection onto the XY plane of the current UCS. The command trims objects that do not intersect with the cutting edge in 3D space.
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View
Specifies projection along the current view direction. The command trims objects that intersect the boundary in the current view.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-A919E808-1108-4DC0-9DC0-916E81B51782.png]
Edge
Determines whether an object is trimmed at another object's extrapolated edge or only to an object that intersects it in 3D space.
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Extend
Extends the cutting edge along its natural path to intersect an object in 3D space.
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No Extend
Specifies that the object is trimmed only at a cutting edge that intersects it in 3D space.
Note: When trimming hatches, do not set Edge to Extend. If you do, gaps in the trim boundaries will not be bridged when trimming hatches, even when the gap tolerance is set to a correct value.
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Erase
Deletes selected objects. This option provides a convenient method to erase unneeded objects without leaving the TRIM command.
[bookmark: _Toc506805959]EXTEND
Extends objects to meet the edges of other objects.
Access Methods
Tool Set: Drafting tab > Modify panel > Extend. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-74AC1D5E-0799-450B-8370-58FEE9FF962E.png]
Menu: Modify > Extend.
To extend objects, first select the boundaries. Then press Enter and select the objects that you want to extend. To use all objects as boundaries, press Enter at the first Select Objects prompt.
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The following prompts are displayed.
Current settings: Projection = current, Edge = current
Select boundary edges...
Select objects or <select all>: Select one or more objects and press Enter, or press Enter to select all displayed objects
Select object to extend or shift-select to trim or [Fence/Crossing/Project/Edge/Undo]: Select objects to extend, or hold down SHIFT and select an object to trim, or enter an option

Boundary Object Selection
Uses the selected objects to define the boundary edges to which you want to extend an object.
Object to Extend
Specifies the objects to extend. Press Enter to end the command.
Shift-Select to Trim
Trims the selected objects to the nearest boundary rather than extending them. This is an easy method to switch between trimming and extending.
Fence
Selects all objects that cross the selection fence. The selection fence is a series of temporary line segments that you specify with two or more fence points. The selection fence does not form a closed loop.
Crossing
Selects objects within and crossing a rectangular area defined by two points.
Note: Some crossing selections of objects to be extended are ambiguous. EXTEND resolves the selection by following along the rectangular crossing window in a clockwise direction from the first point to the first object encountered.
Project
Specifies the projection method used when extending objects.
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None
Specifies no projection. Only objects that intersect with the boundary edge in 3D space are extended.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-9034DB77-D75E-4FE2-AB52-2D09020976FA.png]
UCS
Specifies projection onto the XY plane of the current user coordinate system (UCS). Objects that do not intersect with the boundary objects in 3D space are extended.
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View
Specifies projection along the current view direction.
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Edge
Extends the object to another object's implied edge, or only to an object that actually intersects it in 3D space.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-8BD013DC-F504-43C1-857A-06AD6F66F4D6.png]
Extend
Extends the boundary object along its natural path to intersect another object or its implied edge in 3D space.
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No Extend
Specifies that the object is to extend only to a boundary object that actually intersects it in 3D space.
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Undo
Reverses the most recent changes made by EXTEND.
[bookmark: _Toc506805960]EXPLODE
Breaks a compound object into its component objects.
Access Methods
Tool Set: Drafting tab > Modify panel > Explode. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-28962630-A678-4897-B2D0-D4B92429177D.png]
Menu: Modify > Explode.
Explodes a compound object when you want to modify its components separately. Objects that can be exploded include blocks, polylines, and regions, among others.
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The color, linetype, and lineweight of any exploded object might change. Other results differ depending on the type of compound object you're exploding. See the following list of objects that can be exploded and the results for each.
To explode objects and change their properties at the same time, use XPLODE.
Note: If you're using a script or an ObjectARX ® function, you can explode only one object at a time. (Not applicable to AutoCAD LT.)
Here are the results of EXPLODE for each of the following types of objects:
2D Polyline
Discards any associated width or tangent information. For wide polylines, the resulting lines and arcs are placed along the center of the polyline.
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3D Polyline
Explodes into line segments. Any linetype assigned to the 3D polyline is applied to each resulting line segment.
3D Solid
Explodes planar faces into regions.
Nonplanar faces explode into surfaces. (Not applicable to AutoCAD LT.)
Annotative Objects
Explodes the current scale representation into its constituent parts which are no longer annotative. Other scale representations are removed.
Arc
If within a nonuniformly scaled block, explodes into elliptical arcs.
Array
Explodes an associative array into copies of the original objects.
Block
Removes one grouping level at a time. If a block contains a polyline or a nested block, exploding the block exposes the polyline or nested block object, which must then be exploded to expose its individual objects.
Blocks with equal X, Y, and Z scales explode into their component objects. Blocks with unequal X, Y, and Z scales (nonuniformly scaled blocks) might explode into unexpected objects.
When nonuniformly scaled blocks contain objects that cannot be exploded, they are collected into an anonymous block (named with a “*E” prefix) and referenced with the nonuniform scaling. If all the objects in such a block cannot be exploded, the selected block reference will not be exploded. Body, 3D Solid, and Region entities in a nonuniformly scaled block cannot be exploded. (Not available in AutoCAD LT.)
Exploding a block that contains attributes deletes the attribute values and redisplays the attribute definitions.
Blocks inserted with external references (xrefs) and their dependent blocks cannot be exploded.
Blocks inserted with MINSERT cannot be exploded. (MINSERT is not available in AutoCAD LT.)
Body
Explodes into a single-surface body (nonplanar surfaces), regions, or curves.
Circle
If within a nonuniformly scaled block, explodes into ellipses.
Leaders
Explodes into lines, splines, solids (arrow heads), block inserts (arrow heads, annotation blocks), multiline text, or tolerance objects, depending on the leader.

Mesh Objects
Explodes each face into a separate 3D face object. Color and materials assignments are retained. (Not available in AutoCAD LT.)
Multiline Text
Explodes into text objects.
Multiline
Explodes into lines and arcs.
Polyface Mesh
Explodes one-vertex meshes into a point object. Two-vertex meshes explode into a line. Three-vertex meshes explode into 3D faces.
Region
Explodes into lines, arcs, or splines.



[bookmark: _Toc506805961]LAB SESSION 3
Develop geometry of planar machine parts by using Advanced Editing Commands like Fillet, Chamfer, Array, Splinedit, Pedit, etc.

[bookmark: _Toc506805962]Learning Objective:
At the end of this study, the student will be able to develop geometry of planar machine parts by using Advanced Editing Commands like Fillet, Chamfer, Array, Splinedit, Pedit, etc
[bookmark: _Toc506805963]Apparatus
In order to complete the demonstration, we need a equipment. 
· Auto CAD Software
· Intel core i3 or above
· Compatible Microsoft Windows 
· Mouse or other pointing device
· CD-ROM drive

[bookmark: _Toc506805964]Introduction:
By now students have learned almost all basic ‘draw’ and ‘modify’ tools. This lab session will test their learning through a simple test in which students should be able to draw different views of the given engineering part. Later on few advanced editing commands will be introduced and practiced.

[bookmark: _Toc506805965]Instructions:
1. Open AutoCAD 2015 by double clicking on its icon [image: ]situated somewhere on the desktop.
2. Change the view to AutoCAD Classis by choosing the appropriate option from the menu at the Quick Access Toolbar.
3. Properties Toolbar: [image: ] 
This toolbar offers different options for changing the outlook of the lines drawn on the workspace. For the time we will learn to change the ‘Line Type’ only. 
The second drop-down menu gives the option to change the ‘Line Type’. Drop it down and click ‘other…’ to open the ‘Line Type’ options. Or you can select ‘Line Type’ from the ‘Format Menu’ to open the options. Following the option window. [image: ]
Click on the ‘Load’ button to open another window from which you can load/reload various available line types. Select HIDDEN line type and press enter to load it.
[image: ] 
Now in order to draw a hidden line select HIDDEN line type from the drop down menu in the Properties toolbar Line Type menu. If you want to change the line type of any already drawn object then select the object and select HIDDEN from the Line Type menu.

[bookmark: _Toc506805966]Advanced Editing Commands
[bookmark: _Toc506805967]FILLET
Rounds and fillets the edges of objects.
Access Methods
Tool Set: Drafting tab > Modify panel > Fillet drop-down > Fillet. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-96B6BF37-E721-4F8B-BDC9-22D1F1036AC4.png]
Menu: Modify > Fillet.

A round or fillet is
· an arc that is created tangent between two 2D objects.
· a curved transition between two surfaces or adjacent faces on a 3D solid.
In this example, an arc is created tangent to the selected lines, which are trimmed to meet the endpoints of the arc.
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Create 2D Fillets
A round or fillet can be created between two objects of the same or different object types: 2D polylines, arcs, circles, ellipses, elliptical arcs, lines, rays, splines, and xlines.
If the two selected objects are on the same layer, the arc defined is created on that layer. Otherwise, the arc is created on the current layer. The layer affects object properties including color and linetype.
The following prompts are displayed when creating a 2D fillet.
First Object
Select the first of two objects or the first line segment of a 2D polyline to define the fillet.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-2016A0A5-070D-4C13-BD5F-43EB08190F6F.png]
Second object or shift-select to apply corner
Select the second object or line segment of a 2D polyline to define the fillet.
You can also hold down the Shift key before selecting the second object or line segment of a 2D polyline to extend or trim the selected objects to form a sharp corner. While Shift is held down, a temporary value of zero is assigned to the current fillet radius value.
If the selected objects are straight line segments of a 2D polyline, the line segments can be adjacent to each other or separated by one other segment. When the selected segments are separated by a segment, the segment that separates them is removed and replaced with the fillet.
The direction and length of the arc created is determined by the points picked to select the objects. Always select an object closest to where you want the endpoints of the fillet to be drawn.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-912EFADC-CD36-4011-8913-90602C2A9027.png]
When a circle is selected, the circle is not trimmed; the fillet drawn meets the circle smoothly.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-DCDBDB86-88A9-45E8-97A4-D89C288C8636.png]
Note: Adding a fillet or round to a hatch boundary that was defined with individual objects results in the removal of hatch associativity. If the hatch boundary was defined from a polyline, associativity is maintained.
Undo
Reverses the previous action in the command.
Polyline
Inserts a fillet at each vertex of a 2D polyline where two straight line segments meet. The fillets become new segments of the polyline, unless the Trim option is set to No Trim.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-831A8073-FFAF-4441-AE83-EF5E2C88B930.png]
Select 2D polyline
Select the 2D polyline to insert fillets at each vertex.
If an arc segment separates two straight line segments, the arc segment is removed and replaced with the fillet.
Note: Line segments that are too short to accommodate the fillet radius are not modified.

Radius
Sets the radius for subsequent fillets; changing this value does not affect existing fillets.
Note: A radius value of zero can be used to create a sharp corner. Filleting two lines, rays, xlines, or line segments of a 2D polyline with a radius of zero extends or trims the objects so they intersect.
Trim
Controls whether the selected objects are trimmed to meet the endpoints of the fillet.
· Trim. Selected objects or line segments are trimmed to meet the endpoints of the fillet.
· No Trim. Selected objects or line segments are not trimmed before the fillet is added.
The current value is stored in the TRIMMODE system variable.
Multiple
Allows for the rounding of more than one set of objects.
[bookmark: _Toc506805968]CHAMFER
Bevels or chamfers the edges of two 2D objects or the adjacent faces of a 3D solid.
Access Methods
Tool Set: Drafting tab > Modify panel > Fillet drop-down > Chamfer. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-818989E7-DC2F-4C7F-862C-94A2B42397F5.png]
Menu: Modify > Chamfer.
A bevel or chamfer is
· an angled line that meets the endpoints of two straight 2D objects.
· a sloped transition between two surfaces or adjacent faces on a 3D solid.
The distances and angles that you specify are applied in the order that you select the objects.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-D175BAEA-8DB7-4034-9E82-24B8F08FA45F.gif]
Create 2D Chamfer
A bevel or chamfer can be defined by selecting two objects of the same or different object types: lines, polylines, rays, and xlines.
If the two selected objects are on the same layer, the line defined is created on that layer. Otherwise, the line is created on the current layer. The layer affects object properties including color and linetype.
The following prompts are displayed when creating a 2D chamfer.
First Line
Select the first of two objects or the first line segment of a 2D polyline to define the chamfer.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-2C8C06BB-9073-46BA-9F75-CB84969BF613.png]
Second line or shift-select to apply corner
Select the second object or line segment of a 2D polyline to define the chamfer.
You can also hold down the Shift key before selecting the second object or line segment of a 2D polyline to extend or trim the selected objects to form a sharp corner. While Shift is held down, a temporary value of zero is assigned to the current chamfer distance and angle values.
If the selected objects are straight line segments of a 2D polyline, the line segments can be adjacent to each other or separated by one other segment. When the selected segments are separated by a segment, the segment that separates them is removed and replaced with the chamfer.
Note: Adding a chamfer or bevel to a hatch boundary that was defined with individual objects results in the removal of hatch associativity. If the hatch boundary was defined from a polyline, associativity is maintained.
Undo
Reverses the previous action in the command.
Polyline
Inserts a chamfer line at each vertex of a 2D polyline where two straight line segments meet. The chamfer lines become new segments of the polyline, unless the Trim option is set to No Trim.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-06C680BA-D11E-4BC3-AB98-C3772A68164C.png]
Note: Line segments that are too short to accommodate the chamfer distance are not modified.
Distance
Sets the chamfer distances from the intersecting points of the first and second objects.
If both distances are set to zero, the selected objects or line segments are extended or trimmed so they intersect.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-2C340BC7-62F1-4AC0-B205-932E2696CB90.png]
Angle
Sets the chamfer distance from the intersecting point of the selected objects and the XY angle from the first object or line segment.
If both values are set to zero, the selected objects or line segments are extended or trimmed so they intersect.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-C828AC0D-DD56-4780-97CF-802C44736CB8.png]
Trim
Controls whether the selected objects are trimmed to meet the endpoints of the chamfer line.
· Trim. Selected objects or line segments are trimmed to meet the endpoints of the chamfer line. If the selected objects or line segments do not intersect with the chamfer line, they are extended or trimmed before the chamfer line is added.
· No Trim. Selected objects or line segments are not trimmed before the chamfer line is added.
Note: The current value is stored in the TRIMMODE system variable.
Method
Controls how the chamfer line is calculated from the intersecting point of the selected objects or line segments.
· Distance. Chamfer line is defined by two distances.
· Angle. Chamfer line is defined by a distance and an angle.
The current value is stored in the CHAMMODE system variable.
Multiple
Allows for the beveling of more than one set of objects.
[bookmark: _Toc506805969]ARRAY
Maintains legacy command line behavior for creating nonassociative, 2D rectangular or polar arrays.
List of Prompts
The following prompts are displayed.
Select objects: Use an object selection method
Enter the type of array [Rectangular/Polar] <current>: Enter an option or press Enter
Rectangular
Creates an array of rows and columns of copies of the selected objects.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-91635C32-6E9E-4336-AB19-32B562D72442.png]
Enter the number of rows (---) <1>: Enter a nonzero integer or press Enter
Enter the number of columns (|||) <1>: Enter a nonzero integer or press Enter
If you specify one row, you must specify more than one column and vice versa.
The selected object, or cornerstone element, is assumed to be in the lower-left corner, and generates the array up and to the right.
The specified distance between the rows and columns includes the corresponding lengths of the object to be arrayed.
Enter the distance between rows or specify unit cell (---):
To add rows downward, specify a negative value for the distance between rows. ARRAY skips the next prompt if you specify two points for the opposite corners of a rectangle.
Specify the distance between columns (|||):
To add columns to the left, specify a negative value for the distance between columns. Rectangular arrays are constructed along a baseline defined by the current snap rotation. This angle is normally 0, so the rows and columns are orthogonal with respect to the Xand Y drawing axes. The Rotate option of the SNAP command changes the angle and creates a rotated array. The SNAPANG system variable stores the snap rotation angle.
If you specify a large number of rows and columns for the array, it might take a while to create the copies. By default, the maximum number of array elements that you can generate in one command is 100,000. How you change this limit depends on the product:
· Most AutoCAD-based products: The limit is set by the MAXARRAY setting in the registry. To reset the limit to 200,000, for example, enter (setenv "MaxArray" "200000") at the Command prompt.
· AutoCAD LT: You can change the maximum number of array elements by setting the MaxArray system registry variable using the SETENV command.
Polar
Creates an array by copying the selected objects around a specified center point.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-E0E29461-68FE-4712-ADDD-4FE04E80C1EE.png]
Specify center point of array or [Base]: Specify a point or enter b to specify a new base point
Center Point
Creates an array defined by a center point.
Base
Specifies a new reference (base) point relative to the selected objects that will remain at a constant distance from the center point of the array as the objects are arrayed.
Enter the number of items in the array: Enter a positive integer or press Enter
If you enter a value for the number of items, you must specify either the angle to fill or the angle between items. If you press Enter (and do not provide the number of items), you must specify both.
Specify the angle to fill (+=ccw, -=cw) <360>: Enter a positive number for a counterclockwise rotation or a negative number for a clockwise rotation
You can enter 0 for the angle to fill only if you specify the number of items.
If you specify an angle to fill without providing the number of items, or if you specify the number of items and enter 0 as the angle to fill or press Enter, the following prompt is displayed:
Angle between items: Specify an angle
If you specified the number of items and entered 0 as the angle to fill or pressed Enter, ARRAY prompts for a positive or negative number to indicate the direction of the array:
Angle between items (+=ccw, -=cw): Enter a positive number for a counterclockwise rotation or a negative number for a clockwise rotation
ARRAY determines the distance from the array's center point to a reference point on the last object selected. Reference points include locations such as the center point of a circle or arc, the insertion base point of a block, the start point of text, or the endpoint of a line.
Rotate arrayed objects? <Y>: Enter y or n, or press Enter
In a polar array, the reference point of the last object in the selection set is used for all objects. If you defined the selection set by using window or crossing selection, the last object in the selection set is arbitrary. Removing an object from the selection set and adding it back forces that object to be the last object selected. You can also make the selection set into a block and replicate it.
Path
Evenly distributes copies of the selected object along a path or a portion of a path (same as the ARRAYPATH command).

[bookmark: _Toc506805970]PEDIT
Edits polylines, objects to be joined to polylines, and related objects.
Access Methods
Tool Sets: Drafting tab > Modify panel > Polyline Edit. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-A8FCF43A-F63F-4FCB-AC8D-732FE0F37BBD.png]
Note: Hidden by default. Click [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-78DED619-51B3-49C1-AD71-F928B5F69C0A.png] to display the icon on the tool set panel.
Menu: Modify > Object > Polyline.
Common uses for PEDIT include joining 2D polylines, converting lines and arcs into 2D polylines, and converting polylines into curves that approximate B-splines (spline-fit polylines).
Different prompts are displayed, depending on the type of object you select to edit.
If you select a line, arc, or spline, you are prompted to convert that object to a polyline. Several system variables affect this conversion. The PLINECONVERTMODE system variable determines whether the polylines are created with linear or arc segments. When the PEDITACCEPT system variable is set to 1, this prompt is suppressed, and the selected object is automatically converted to a polyline. The DELOBJ system variable determines whether the original geometry is retained or removed.
The following prompts are displayed.
Select polyline
Specifies a single polyline to work on.
· Object selected is not a polyline. Do you want to turn it into one? Displayed if the object you select is not a polyline. Enter y to convert the object to a polyline or nto clear the selection.
· Specify a precision. Displayed if you select a spline and are converting it to a polyline. The precision value determines how accurately the resulting polyline is fit to the source spline. Enter an integer between 0 and 99.
Note: A high precision value might cause slower performance.
Multiple
Specifies that you want to select more than one object.
· Convert lines, arcs, and splines to polylines? Displayed if any of the objects you select is a line, arc, or spline. Enter y to convert the objects to a polyline or n to clear the selection.
· Specify a precision for spline conversion. Displayed if any of the objects you select is a spline and you are converting them to polylines. The precision value determines how accurately the resulting polyline is fit to the source spline. Enter an integer between 0 and 99. The entered precision value affects all splines in the selection set.


[bookmark: _Toc506805971]LAB SESSION 4
Draw the orthographic views of 3D machine parts and organizing your work by dimensioning, managing with layers and creating blocks in AutoCAD

[bookmark: _Toc506805972]Learning Objective:
At the end of this study, the student will be able to draw the orthographic views of 3D machine parts and organizing the work by dimensioning, managing with layers and creating blocks in AutoCAD

[bookmark: _Toc506805973]Apparatus
In order to complete the demonstration, we need an equipment. 
· Auto CAD Software
· Intel core i3 or above
· Compatible Microsoft Windows 
· Mouse or other pointing device
· CD-ROM drive

[bookmark: _Toc506805974]Introduction:
In this lab session an important aspect of engineering drawing called ‘dimensioning’ will also be taught to the students and they will learn to place dimensions on AutoCAD as well. The lab manual will at the end introduce the concept of layering in AutoCAD to the students. After this lab session, students shall be given various practice tasks and they will be encouraged to practice as much as possible till the end of the semester.


[bookmark: _Toc506805975]Instructions:
1. Open AutoCAD 2015 by double clicking on its icon [image: ]situated somewhere on the desktop.
2. Change the view to AutoCAD Classis by choosing the appropriate option from the menu at the Quick Access Toolbar.

[bookmark: _Toc506805976]Layout Managing Tools
[bookmark: _Toc506805977]Dimension
Creates multiple types of dimensions within a single command session.
Access Methods
Tool Set: Drafting tab > Dimension panel > Dimension. [image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-5EA1A3E0-8630-4E93-9CCA-E6062287F3DD.png]
Menu: Dimension > Dimension.
When you hover over an object for dimensioning, the DIM command automatically previews a suitable dimension type to use. Select objects, lines, or points to dimension and click anywhere in the drawing area to draw the dimension.
The supported dimension types range from vertical, horizontal, aligned, and rotated linear dimensions, to angular dimensions, to radius, diameter, jogged radius, and arc length dimensions, to baseline and continued dimensions. If required, you can change the dimension type using command line options.
The following prompts are displayed.
Select objects
Automatically selects an applicable dimension type for the objects you select and displays the prompts corresponding to that dimension type.
	Selected object type
	Action

	Arc
	Defaults the dimension type to radius dimensions.

	Circle
	Defaults the dimension type to radius dimensions.

	Line
	Defaults the dimension type to linear dimensions.

	Dimension
	Displays options to modify the selected dimension.

	Ellipse
	Defaults to options set for selecting a line.


First extension line origin
Creates a linear dimension when you select two points.
Angular
Creates an angular dimension showing the angle between three points by or the angle between two lines (same as the DIMANGULAR command).
· Vertex. Specifies the point to use as the vertex of the angle.
· Specify first side of angle. Specifies one of the lines that form the angle.
· Specify second side of angle. Specifies the other line that forms the angle.
· Angular dimension location. Specifies where to place the dimension arc line. Depending on the position of the dimension, the quadrant for the dimension changes.
· Mtext. Displays the Text Editor contextual tab, which you can use to edit the dimension text.
· Text. Customizes the dimension text at the Command prompt. The generated dimension is displayed within angle brackets.
· Text angle. Specifies the angle of the dimension text.
· Undo. Returns to the previous prompt.
· Undo. Returns to the previous prompt.
Baseline
Creates a linear, angular, or ordinate dimension from the first extension line of the previous or selected dimension (same as the DIMBASELINE command).
Note: By default, the last created dimension is used as the base dimension.
· First extension line origin. Specifies the first extension line of the base dimension as the extension line origin for the baseline dimension.
· Second extension line origin. Specifies the next edge or angle to dimension.
· Feature Location. Uses the endpoint of the base dimension (ordinate dimension) as the endpoint for the baseline dimension.
· Select. Prompts you select a linear, ordinate, or angular dimension to use as the base for the baseline dimension.
· Offset. Specifies the offset distance from which the baseline dimensions are created.
· Undo. Undoes the last baseline dimension created.
Continue
Creates a linear, angular, or ordinate dimension from the second extension line of a selected dimension (same as the DIMCONTINUE command).
· First extension line origin. Specifies the first extension line of the base dimension as the extension line origin for the continued dimension.
· Second extension line origin. Specifies the next edge or angle to dimension.
· Feature location. Uses the endpoint of the base dimension (ordinate dimension) as the endpoint for the continued dimension.
· Select. Prompts you select a linear, ordinate, or angular dimension to use as the base for the continued dimension.
· Undo. Undoes the last baseline dimension created.
Ordinate
Creates an ordinate dimension (same as DIMORDINATE command).
· Feature location. Prompts for a point on a feature such as an endpoint, intersection, or center of an object.
· Leader endpoint. Uses the difference between the feature location and the leader endpoint to determine whether it is an X or a Y ordinate dimension. If the difference in the Y ordinate is greater, the dimension measures the X ordinate. Otherwise, it measures the Y ordinate.
· Xdatum. Measures the X ordinate and determines the orientation of the leader line and dimension text.
· Ydatum. Measures the Y ordinate and determines the orientation of the leader line and dimension text.
· Mtext. Displays the Text Editor contextual tab, which you can use to edit the dimension text.
· Text. Customizes the dimension text at the Command prompt. The generated dimension is displayed within angle brackets.
· Angle. Specifies the angle of the dimension text.
· Undo. Returns to the previous prompt.
· Undo. Returns to the previous prompt.
Align
Aligns multiple parallel, concentric, or same datum dimensions to a selected base dimension.
· Base dimension. Specifies a dimension to use as basis for the dimensions alignment.
· Dimensions to align. Selects the dimensions to align to the selected base dimension.
Distribute
Specifies the method on how to distribute a group of selected isolated linear or ordinate dimensions.
· Equal. Equally distributes all selected dimensions. This method requires a minimum of three dimension lines.
· Offset. Distributes all selected dimensions at a specified offset distance.
Layer
Assigns new dimensions to the specified layer, overriding the current layer. Enter Use Current or " . " to use the current layer. (DIMLAYER system variable)
Undo
Reverses the last dimension operation.
The following options are displayed when you place a dimension in such a way that it overlaps an existing dimension.
Move away
Arranges the existing dimension and the newly inserted dimension into a baseline dimension type.
Break up
Splits up the existing dimension into two dimensions, and arranges those dimensions into a continued dimension type.
Replace
Deletes the existing dimension and replaces it with the one you insert.
None
Inserts the new dimension on top of the existing dimension.

[bookmark: _Toc506805978]LAYER
Manages layers and layer properties.
Access Methods
Menu: Format > Layers.
Command entry: 'layer for transparent use
Summary
The Layers Palette is displayed.
If you enter -layer at the Command prompt, options are displayed.
[image: http://help.autodesk.com/cloudhelp/2018/ENU/AutoCAD-MAC-Core/images/GUID-6C464045-976D-475F-9855-2AAF63DC3B92.png]
Use layers to control the visibility of objects and to assign properties such as color and linetype. Objects on a layer normally assume the properties of that layer. However, you can override any layer property of an object. For example, if an object’s color property is set to BYLAYER, the object displays the color of that layer. If the object’s color is set to Red, the object displays as red, regardless of the color assigned to that layer.

 Prepared by: Muhammad Moeen Sultan (Assistant Professor ME Dept., UET Lahore KSK)17
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